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Agents secrets, 3 vos écrans!

Mission 8
Mal

Mon personnage
LopArt [V

Dessiner un
personnage qu'ils
aimeraient voir
apparaitre dans un
roman qu'ils ont lu.
Utiliser les différentes
textures. Présenter a la
classe et justifier son
choix.

Une histoire a faire
peur

Publisher [}V ou

Pages ou

Word |V ? ou
PowerPoint [ ! ou
Didapages |V % ou

Keynote

Réaliser une histoire
sur le theme de
I'Halloween avec le
logiciel de son choix
(laisser I'éléve choisir).
Utiliser le schéma du
récit. Penser a la page
titre, le nom de
I"auteur, etc. Ensuite,
personnaliser la mise
€n page.

Exprés pour toi, mon
petit ami

ActivInspire [
ou ‘
Notebook ¥/  ou

Open Sankoré M
Créer un jeu sur un
logiciel de TBI ou tout
autre logiciel de
présentation sur les
formes géométriques
de base pour les éléves
du préscolaire {voir
mission 4 du
préscolaire).

Dino dino .
PowerPoint [} | ou

Keynote ‘, ou

ActivInspire [V ?

ou
Notebook [/  ou

Open Sankoré [
Aprés avoir fait, en
classe, une carte
d’exploration sur les
dinosaures., réaliser, en
équipe, a l'aide d'un
logiciel de présentation
un support visuel a une
présentation orale sur
un des éléments vus en
classe. Insérer des
sons et des transitions.

Les olympiades
frileuses

LopArt [
Dessiner, sur le théme
des olympiades d'hiver.
Faire le fond en arriére-
plan et les personnages
au premier plan.
Utiliser deux textures
différentes.

Boolé... quoi?
www.google.ca/
Utiliser Google pour
trouver une recette
contenant deux de ses
ingrédients préférés.
Explorer les opérateurs
booléens.

Suggestion: copier
I'URL et I'envoyer a la
maison par courrier
électronique.

Chanson sucrée!
Audacity |

En équipe, composer
une chanson sur un air
connu ayant pour
théme « La cabane a
sucre » et |'exporter en
MP3.

Suggestion : la publier
sur le site Web de
I'école.

Pousse pousse!
Flip Boom [

Aprés avoir fait germer
et pousser une plante
dans la classe, faire
pousser une fleur ou
une plante a |'aide du
dessin animé. Ajouter
un fond.
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Les outils du portfolio

@@

Canevas Informations
L J" — .
f 3

J Carte
Diaporama Musée postale

EX=,

Exportation Impression Recyclage

Astuces
‘z Pour transférer une image d’'un portfolio LopArt a un autre, appluyez sur la O3 ]1
touche majuscule avant d’appuyer sur I'icbne d’exportation. L ,J

£ Pour récupérer son dessin en format .lop, cliquez sur la majuscule puis sur la page blanche.

‘z Pour démarquer un détail ou une forme, dessiner la ligne contour apres le dessin, pour éviter de dépasser lors du
remplissage.
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Les outils de dessin du canevas

Annuler ou vijtesse
Couleurs Duo-tons Textures rétablir d’animation

l Transparence \

v

5
L
@
Niveaux de Trait Taille Animation
textures
Les textures
Niveau 1 Niveau 2
1)(2)(3)(4 1)(2)(3)(4 .
1. Gouache 7 W 1. Ecailles
I ; 2. Aquarell¢ i l‘ a'.g-_ ¥ III.f 2. Taches
3. Aérosol gt 3. Eau
e \
i 4. Cire - éq\; _ 4.
| 5. Fusain ¥ “},.e . Branches/Foin
6. Encre Ny gh Ml 5. cheveux
7. Cire : 6. Feuilles
5 6 7 8 8. Pastel 5 6 7 8 7. Ifrisous
o CAAv~A

. Ecorce

. Etoiles

. Pétales/Cercles
. Ecorce

. Guirlande

. Feuilles

elouse/Fourrure
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Les couleurs et les duo-tons

Tons de gris Couleurs Duo-tons

rw A oy

Couleur Goutte d’eau pour
sélectionnée I'estompage

% Astuce : Pour retrouver une couleur, cliquez sur celle-ci dans le canevas (sur le dessin) en enfongant la touche
majuscule. Ainsi, tous les parameétres précédemment établis se réaffichent.
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Effectuer une mise en page avec Publisher

recit

1. Ouvre Publisher

Insére le titre

D Gien Whaoe Pennon Pam Ooh Dty Dapagion Ay of piipenage |

DCse e BY N NG S™ =0 O

le 00/ BRE

o

Ecris verticalement

Italique -

- |5 IX

i1d (Composition nom encogittrde) - Microsolt Publishee

Gras

[= Teste bt (A e ] (] 7Ee[<hd] [¥] [E[C] [s[Q]s Donne une bordure
F DT L T TR O T TN - ” f 4R W FTe LT | TR TR _‘Mlh B a1 e I ek b =

Pteer Cdtion #

Donne une fome || Choisis 1a Ajusterle tize Ajoute une ombre
speciale 2 ton police de Votre texie wi

caracteres

titre. Colore ou donne une

trame aux lettres

ncdow s symbcle | Moo & Faichage | Applique une rotation

1
'i_:
1
"
=
d
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Insere du texte

Bwr (on WO Jewton Fame Ok Tbieas Owpeglion fyuson o pilpotage |
DS & ' "B Y o L% 4Ee ™ =0

e 007 BR X

Grosseur du caractere

T Smos | Outlinn a0
T Smple Indust Shaded 10
¥ Smpie Otiine Pat sesia-ges

00/ R X O> ~
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Insére une image clipart

id (Compesition son enregittrée) - Micresoft Publisher

Ecver Edtion Yfichage Jroertion Format Quils Tabless Dspogtion Fysion et publpostage T
D@ ST~ QR OG T o =+ 03
dZ= "gaadg

premier icone (inserer)

mei‘-h B 1o s La bibbot? - »

U, 3 amu Oocunm 004-
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Inscns le nom de I'image que tu veux.
Clique sur I'image et sélectionne le

~
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SCRAPBOOKING DIGITAL

AAAAA Avec PowerPoint

DES CHENES

1. Insérez le disque dans le lecteur et ouvrez une nouvelle présentation
(vide) PowerPoint

2. Enregistrez

3. Insérez un arriére-plan

Format > Arriére-plan...
Cliquez sur la fleche v | et sélectionnez Motifs et textures...

Onglet Image > Bouton Sélectionner une image...
Choisissez l'arriere-plan de votre choix
* Regarder dans : (cliquez sur la fleche et choisissez le disque)
» Choisissez votre theme
e Choisissez un papier (double-cliquez)
* OK
* Appliquer

4. Insérez les éléments décoratifs

Insertion

Image > A partir du fichier...

Choisissez I'image (double-cliquez)

Jouez avec lI'image (redimensionnement, rotation, etc.)
Répétez ces étapes jusqu’a ce que la page soit a votre go(t

5. Insérez des photos ou d’autres images

Assurez-vous que la barre d’outils image soit accessible
Clic droit sur I'image pour changer l‘ordre

Lorsque le montage est a votre go(t, groupez les éléments (plus facile
pour le déplacement, surtout lorsque I'on utilise des lettres).
On peut les dissocier au besoin.

Suzanne Havey (adapté de Sonya Roussy CS des Trois-Lacs) * février 2011



6. Pour écrire du texte

Insertion > Zone de texte

Ecrivez et mettez en forme le texte (police, couleur, grosseur, etc.)
Placez la zone de texte a I’endroit voulu

Jouez avec le bloc de texte (rotation, plans, etc.)

Petits extras

1. Pour changer le format des diapositives :

Fichier > Mise en page...

Cliquez sur la fleche \ V‘ et sélectionnez Personnalisé

Ex : 30 cm X 30 cm

2. Pour faire une image de votre diapositive :

Sur la diapositive : Fichier > Enregistrer sous...
Enregistrer dans : (D ou X)

Nom de fichier :

Type de fichier > JPEG ou GIF

Diapositive en cours uniquement

*x* N'oubliez pas d’enregistrer votre travail **x*

Amusez-vous!

Suzanne Havey (adapté de Sonya Roussy CS des Trois-Lacs) ¢ février 2011
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E Tracer des formes avec Activinspire

recit

/ v

1 /9
. Ouvre Activinspire W/
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Les opérateurs de recherche

Généralités

Lorsque vous soumettez une requéte de base, Google renvoie uniquement les pages
Web qui contiennent tous les mots spécifiés (qu'ils soient adjacents ou non) ; par
conséquent, pour mieux cibler votre recherche et obtenir une liste de résultats a la fois
plus courte et plus pertinente, il suffit d'ajouter d'autres termes de recherche a votre
requéte. En spécifiant davantage de mots, les résultats deviennent un sous-ensemble
spécifique des pages renvoyées par la requéte originale, qui était « trop vague ».

Exclure des mots

Pour exclure un mot de votre recherche, placez le signe moins ( - ) immédiatement
devant ce mot. (Le signe moins doit étre précédé d'un espace.)

Recherche d'expression

Pour rechercher une expression (par exemple, « imprimante laser couleur »), utilisez
des guillemets. Lorsque vous placez plusieurs mots entre guillemets (par exemple,

" mots entre guillemets "), Google les considére comme une seule chaine de caractéres
et recherche uniquement les documents qui contiennent ces mots dans la méme
séquence. Toutefois, cette régle ne s'applique pas aux « mots vides », qui exigent le
signe plus ( + ) pour étre pris en compte.

Les recherches portant sur plusieurs mots placés entre guillemets sont particuliérement
utiles pour retrouver une citation, un proverbe, un titre de livre ou de film, un titre ou un

vers de chanson, un lieu géographique, un personnage célébre.

Certains caractéres sont reconnus par Google comme connecteurs d'expression : tiret
(-), barre oblique standard ( /), point ( . ), signe égal ( = ).

Mission possible en TIC e Julie Aubé et Suzanne Harvey « RECIT de la CSDC



Opérateurs de ciblage

Certaines chaines de caractéres, ou « opérateurs », modifient le comportement de
Google. Par exemple, 'opérateur « site: » (sans les guillemets). Pour limiter la
recherche & un site ou & un domaine spécifique, utilisez la syntaxe

« site:domaine.com » dans le champ de recherche de Google.

Type de recherche ‘ Exemple

un ou plusieurs mots moulin vent

Description

Trouve les documents contenant autant de mots
que possible et les présente par ordre de
pertinence.

mots entre guillemets "énergie éolienne"

Trouve précisément la suite de caractéres entre
guillemets.

lettres majuscules VENT

Trouve les mots contenant les lettres
majuscules seulement; les requétes en lettres
minuscules ne font pas la distinction.

mot obligatoire +énergie +éolienne

Trouve les pages contenant au moins les mots
précédés du symbole "+" .

Exclut les pages contenant le mot précédé du

mot exclus énergie -éolienne o

symbole "-" .

Trouve les pages contenant les mots composés
troncature vent* au moins des caractéres précédant le caractére

de troncature (ex. pour "vent*": venteux, ventricule,
etc.)

Opérateurs Booléens

Exemple

Symbole Signification

Description

, T .| Trouve les documents contenant l'une de ces
OR ou énergie éolienne OR solaire |, .
énergies.
- sauf énergie éolienne -solaire | Exclut I'énergie solaire des résultats.
. C Trouve les documents précisément sur le mot,
+ et énergie +éolienne , .
tel que vous l'avez orthographié.

Mission possible en TIC e Julie Aubé et Suzanne Harvey « RECIT de la CSDC
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Enregistrement a I'aide d'un microphone

Réglez le volume d’enregistrement.

& .

Faites un essai pour vérifier les niveaux.

5 Cliquez sur le bouton Enregistrer et captez
quelques secondes de son.

N Cliquez sur le bouton Arrét pour stopper

I'enregistrement.

Trop fort

Supprimez la piste d’essai.

Enregistrez tout le texte d'un personnage, puis cliquez sur arrét. Prendre soin de laisser un
peu de silence AVANT et APRES chaque réplique.

Enregistrez autant de pistes qu'il y a de personnages. Nommez chaque piste pour vous
aider a faire votre montage.

Enregistrez le résultat: Fichier => Enregistrer sous.

;4— MH
Trop faible Correct !

X|ristert  w| 1,0]

3
3
h

Déplacer la piste vers e bas

Faorme d'onde (dE)
Spectre
Hauteur (EAC)

ATTENTION: Il y a aura un dossier (_data) de créé ainsi que deux fichiers (.aup et .bak). Si vous voulez déplacer votre

enregistrement, vous devez déEIacer ensemble le dossier ainsi gue les deux fichiers.

© Karine St-Georges
Cs des Chénes 2009



Exporter le montage en format wav ou en format mp3

Edition  Affichage Projet Generer  Effet Pour exploiter votre montage dans un autre logiciel, vous devez I'exporter
Mowrveau Chrl+H dans un format universel.
Ouwrir,.,, k40
Fermer CEEH

Enregistrer le projet sous. ..

Praojets récents, ., »

Exporter an WAY. ., < Le format wav offre la meilleure qualité sonore mais occupe beaucoup de
place sur le disque dur.

Expatter comme MP3... Le format mp3 offre une qualité sonore acceptable et divise environ par 10
I'espace nécessaire sur le disque dur. Le mp3 est le format standard d'Internet.

Exporter comme Cgg Yorbis Le format Ogg Vorbis est un format libre. Il offre une qualité sonore légére-
ment supérieure au mp3 tout en occupant un peu moins d’espace. Il faut un
logiciel spécialisé pour lire ces fichiers, mais ce logiciel est gratuit.

Export Multiple... Si vous désirez télécharger Audacity, vous pouvez aller a I'adresse suivante:
T http://audacity.sourceforge.net/
Imprimer...

Pour exporter en mp3, vous devez installer un utilitaire nommé
Quikker LAME MP3 ENCODER. Il est possible de télécharger I'utilitaire au méme en-
: : : droit que le logiciel

NG Choisir un emplacement pour le fichier,
donner un nom au fichier et enregistrer.

Dang le fichier erpaorté, vos pistes seront mélangées en deus canaux stéréa

[ Me plus montrer cet avertizeement,

0K

Cli N
CIQUCZ SUTUIN,
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